Comparative Study on Automation Testing using Selenium Testing Framework and QTP

Jagannatha S¹, Niranjanamurthy M², Manushree SP³, Chaitra GS⁴

¹Associate Professor, Department of MCA, MSRIT, Bangalore-54, INDIA
²Assistant Professor, Department of MCA, MSRIT, Bangalore-54, INDIA
³Student, Department of MCA, MSRIT, Bangalore-54, INDIA
⁴Student, Department of MCA, MSRIT, Bangalore-54, INDIA

¹jagannathast@gmail.com; ²niruhsd@gmail.com; ³manushreesp.27@gmail.com; ⁴chaitrags23@gmail.com

Abstract — Selenium is a web application testing tool and also it is an open source freeware. This automation testing framework has gained wide acceptance as a popular and successful mode of website automated testing in a very short time span. These tools are widely used for testing graphical user interface and functionality of web-based applications developed for all types of industries such as e-commerce, travel, biotech, pharmaceuticals, and other mechanization. This testing freeware renders a cost-effective way which is an open source testing framework for performance and other parameters to ascertain compatibility, accuracy, aspect and consumption of web applications. This paper we did study on the various components of Selenium such as Selenium IDE, Selenium RC, Selenium WebDriver, Selenium Grid Most commonly used commands and comparison with QTP.

Keywords — Selenium Testing, Selenium IDE, Selenium RC, Selenium WebDriver, Selenium Grid, Comparison with QTP

I. INTRODUCTION

Selenium is a portable software testing framework for web applications. Selenium contributes a record-recap appliance for authoring tests without learning a test scripting language such as Selenium IDE. Selenium is a collection of various software tools each with a different approach to support test automation. Maximum Selenium Quality Assurance Engineers focus on the one or two tools that most meet the needs of their task, but studying all those tools will give you many different options for approaching different test automation issues. The complete testing suite of tools which is available results in a rich set of testing functions specifically geared to the needs of testing of web applications. These operations are totally adaptable that gives many choices for locating User Interface elements and comparing expected test results against actual behaviour of an application. One of Selenium’s important feature is the support for executing one’s tests on multiple browser platforms [8]. Selenium is basically used for the functional testing of web based applications. It can be used for testing in the continuous integration environment. It is also useful for agile testing. It is the free software that works on all three major platforms – Windows, Mac and Linux. Selenium supports a wide range of programming languages that covers most, not limiting itself to only Java, Ruby, Perl, PHP, C# and Python. The best part of Selenium is it enables you to test web
applications with zero knowledge of any test scripting language. You can write tests in a number of popular programming languages such as Java, Ruby, Perl, PHP, C# and Python. The tests can be built in most of the web browser platforms. Selenium establishes on most of the platforms namely Linux, Windows and Macintosh. This open-source freeware is released under the Apache 2.0 license and can be downloaded and used without any charges. This paper explains us what exactly the selenium is all about ie the need of selenium testing framework, its components and how it actually differs from QTP tool.

II. RELATED WORK

Selenium is an open source automated testing suite for web applications across different browsers and platforms which supports multiple programming language. Selenium is a type of functional web testing tool. Selenium is not only a single tool which has four components: Selenium Grid, Selenium Remote control, Selenium IDE and Selenium Web Driver. Selenium Integrated development environment is a Firefox plug-in which can be used to develop test cases, Selenium Remote control run tests inside every JavaScript compatible browser (which is now available on all web browsers) using a wide range of programming language, Web Driver was developed for better support dynamic web pages where elements of a page may change without the page itself being reloaded and Selenium Grid allows you to run your tests on different machines against different browsers.[1]

The complete Selenium test automation is designed specifically for web testing. It will not allow in automating other technologies. The Selenium result is very compound which involves the integration of many other components. The process for Selenium test automation makes necessary for a developer test his skills set. When choosing a tool in this area, it is very important to take into cogitation much more the cost. I conclude that selenium may be right for certain specific situation, but QTP can be the better choice in many more situations.[2]

Selenium is a tool designed to generate automated tests and enhance the testing performance. Automated testing is used by software developer to save assets and time. Selenium is known an open source automation testing tool for web based application. It will run directly in the web browser and supports almost all available browsers like Google Chrome, Mozilla Firefox, Microsoft’s Internet Explorer, Opera, and Macintosh Safari. It will run on all platforms like Linux, Windows and Mac. It is a very useful tool for System functional testing and browser relationship or compatibility testing. It is really strong as compare to other available automation tools and is very flexible and simple to use.[3]

Today everything is web based thus it is becoming more and more complex. For this vast information platform and quick release cycle quick regeneration of site is required. This requires the web application to be all-inclusive, extensibility and efficiency. For this there exists some framework which includes automation tools. In this paper we will discuss about the Selenium automation testing tool that is used in framework for better results. As we know sometimes there may be a problem arising to choose proper framework for automation testing. Selenium is a set of tools functioning with many Operating Systems, browsers, programming languages and other different testing framework, individually with other different approaches in support of automation test for testing web based application.[4]

Software testing is really a time consuming process and also complex. One way of reducing the effort associated with testing is to generate test data automatically. Testing is the most important part of software development. Quality is not an absolute term, it is value to some people or a person. With that in mind, testing can never completely establish the correctness of arbitrary computer software testing.
furnishes a criticism or comparison that compares the state and behaviour of the product against a specification. Software testing process can yield several artifacts, so we proposed a model to improve quality and correctness and also we reduce the software testing time. [5] Writing auto testing is a required engineering technique that can save money and time, and in turn helps businesses better retort to changes in real world. But if we use testing framework is not properly used, there will be more problems to be caused. An auto testing framework based on the Selenium is discussed in this article which can help with these problems. The framework will use Selenium application framework to get page value, DbFit to initiate the database, FitNesse which is used to manage the test component, and a DSL is used to write the test components. This could highly reduce the amount of lines of testing code and the time taken for the project development, lowering the error rate, facilitate writing component/fixture table, improve the productiveness of coding, and quality of final product.[6]

Selenium is a set of powerful different software tools working with many browsers, programming languages, operating systems and testing frameworks each with a different approach to supporting automation test for testing web-based applications. JMeter which is used to replicate a heavy load in a server, network, any object to test its potency or to analyse overall performance under various load types. JMeter operates at protocol-level, besides the Selenium works at the user-level. Here in this paper, authors frame an automatic software testing framework for web applications based on the JMeter and Selenium which is both open-sources. With the use of the software framework, we readily improve the reusability and extensibility of automated test.[7]

one extension of the Selenium RC tool to perform tests in web applications that require checking data in databases. This verification is operated using new functions implemented into the Selenium framework's core. These functions allow opening as well as closing database connection and comparing test data with data stored in the database used by the web application. This solution intent to contribute to the system quality by reducing the effort during the testing process, as the verification of UI and database elements will be performed at the same time during execution of the test scripts. A case study is described to evaluate the impact of the proposed tool in terms of effort and rate of automation in the development of a new web application project.[11]

A common practice for system testing of web-based applications is to perform the test cases through a web browser. These tests are often recorded and handled by a record and replay tool, such as Selenium IDE. Mining specifications from such tests can be very useful for understanding, verifying, and debugging the system under test. This paper presents an access to mining a behavior specification from a Selenium IDE test suite such that (a) it captures the behavior of the tests at a high level of abstraction, (b) the behavior can be simulated, and (c) all the tests are completely reproducible from the specification.[12]

III. SELENIUM COMPONENTS

1. Selenium IDE
2. Selenium RC
3. Selenium WebDriver
4. Selenium Grid
1- Selenium IDE
Selenium Integrated Development Environment (IDE) is a Firefox plugin that lets testers to allow testers to record their actions as they follow the workflow that they need to test. Selenium IDE has a recording feature, which archive user actions as they are performed and then exports them as a reusable script in one of many programming languages that can be later executed. It provides a Graphical User Interface for recording user actions using Firefox which is used to learn and use Selenium, but can only be used only with Firefox browser as other browsers are not supported. However, The recorded scripts can be converted into various programming languages supported by Selenium and the scripts can be executed on various other browsers as well.

a) Most commonly used commands
These are the regularly used commands in the Selenium IDE:
open: Used to open a page using a URL.
click: Clicks the object or element in the page.
clickAndWait: Enforce a click operation, and then optionally waits for a new page to load.
verifyTitle: Authenticate the expected title and then continues to run if it fails.
assertTitle: Verifies page title and then stops the execution if it fails.
verifyTextPresent: Verifies that if expected text is present somewhere on the page.
verifyElementPresent: Authenticates an expected User Interface element, as defined by its HTML tag.
verifyText: Authenticate whether the expected text and its corresponding HTML tag are present on the page.
waitForPageToLoad: Recess execution until there is an expected new page loads.
waitForElementPresent: Pauses execution until an expected User Interface element, as defined by its HTML tag, is present on the page. This is Used with AJAX calls.[9]

b) Sample for writing Test suite Using Selenium IDE

Test Case - 1:
• Open (Example: Type www.google.com)
• Type “energy efficient”, in the Google Search Input Box
• Click outside on an empty spot
• Click Search Button
• Verify the Text Present as “energy efficient”
• Assert the Title as “energy efficient - Google Search”
• Save the test case with .HTML Extension.
Test Case - 1:
• Open (Example : Type www.google.com)
• Type “Selenium RC”, in the Google Search Input Box
• Click outside on an empty spot
• Click Search Button
• Verify the Text Present as “Selenium RC”
• Assert the Title as “Selenium RC - Google Search”
• Save the test case with .HTML Extension.

Steps for creating test suite:
1. Create more Tc’s save each Test Case with <.html> extension code.
2. Open Firefox
3. Open Tools ->Selenium IDE
4. File -> Open -> new Test Suite
5. File -> Open->Add Test cases
6. Add more test cases
8. Run the test suite

2 - Selenium RC
Selenium Remote Control (RC) is a type of test tool that allows you to write automated web application UI tests in any programming language against any HTTP website using any mainstream JavaScript-enabled browser.

The RC server also bundles Selenium Core, and automatically loads it into the browser. Selenium opens multiple browsers (one at a time) in this mode and then runs the recorded test-cases which are saved in the language of your choice. This helps in enhancing the test cases with programming techniques to cover all the required checks and test scenarios.

Selenium Remote Control(RC) was the flagship testing framework that allowed more than simple browser actions and linear execution. It makes use of the full power of programming languages such as Java,C#,PHP,Python,Ruby and PERL to create more complex tests.

Selenium RC works in such a way that the client libraries communicate with the Selenium RC Server passing each Selenium command for execution. Then the server passes the Selenium command to the browser using Selenium-Core JavaScript commands.
Selenium RC comes in two parts.

- The Selenium Server launches and kills browsers in addition to that it interprets and executes the Selenese commands. It also acts as an HTTP proxy by intercepting and verifying HTTP messages passed between the browser and the application under test.
- Client libraries that provide interface between each one of the programming language (Java, C#, perl, python and php) and the Selenium-RC Server.

3 - Selenium WebDriver

Selenium WebDriver is the successor to Selenium RC which sends commands directly to the browser and retrieves results. WebDriver is a tool for automating testing web application popularly known as Selenium 2.0. WebDriver uses a different underlying framework while Selenium Remote Control uses javascript Selenium-Core embedded within the browser which has got some limitations. Webdriver interacts directly with the browser without any intermediary unlike Selenium remote control which depends on a Server. It is used in the below context:

The developer community in Selenium strive hard to improve Selenium continuously and Integrating WebDriver with selenium is one among them.

- Mult-browser testing including improved functionality for browsers not well-supported by Selenium Remote control (selenium 1.0)
  - Handling multiple frames, multiple browser windows, popups, and alerts.
  - Complex Page navigation.
  - Advanced user navigation such as Drag-and-drop.
  - AJAX-based UI elements

Architecture: Selenium WebDriver
Selenium RC Vs WebDriver

<table>
<thead>
<tr>
<th>Selenium RC</th>
<th>Selenium WebDriver</th>
</tr>
</thead>
<tbody>
<tr>
<td>Selenium RC architecture is complicated as the server needs to be up and running before starting a test.</td>
<td>WebDriver's architecture is simpler than Selenium RC as it controls the browser from the OS level.</td>
</tr>
<tr>
<td>Selenium Server acts as a middle man between browser and selense commands</td>
<td>WebDriver interacts directly to the browser and uses the browser's engine to control it.</td>
</tr>
<tr>
<td>Selenium RC script execution is slower since it uses a Javascript to interact with RC</td>
<td>WebDriver is faster as it interacts directly with browser.</td>
</tr>
<tr>
<td>Selenium RC cannot support the headless as it needs a real browser to work with.</td>
<td>WebDriver can support the headless execution</td>
</tr>
<tr>
<td>It's a simple and small API</td>
<td>Complex and a bit large API as compared to RC</td>
</tr>
<tr>
<td>Less Object oriented API</td>
<td>Purely Object oriented API</td>
</tr>
<tr>
<td>Cannot test mobile Applications</td>
<td>Can test iPhone/Android applications</td>
</tr>
</tbody>
</table>

4 - Selenium Grid

Selenium Grid is a tool used to run parallel tests across different machines and different browsers simultaneously which results in minimized execution time.

Selenium Grid is a tool that distributes the tests across multiple physical or virtual machines so that we can execute script in parallel (simultaneously) that results in cutting down the time required for running tests. This dramatically accelerates testing across browsers and across platforms by giving us quick and accurate feedback.

Selenium Grid allows us to execute multiple instances of WebDriver or Selenium Remote Control tests in parallel which uses same code base, hence code need NOT be present on the system they execute. The selenium-server-standalone package includes Hub, WebDriver, and Selenium RC to execute the scripts in grid.

Selenium Grid has a Hub and a Node:

Hub - The hub can also be understood as server which acts as the central point where the tests would be triggered. A Selenium Grid has ONLY one Hub and it is launched on a single machine once.

Node - Nodes are the Selenium instances that are attached to the Hub which will execute the tests. There can be one or more nodes in a grid which can be of any OS and can contain any of the Selenium supported Browsers.

Architecture: Architecture of Selenium Grid
Working with Grid: In order to work with the Grid, we need to ensure that we follow certain protocol.: Configuring Hub , Configuring Nodes, Develop Script, XML Preparation, Test Execution, Result Analysis. [13]

IV. COMPARISON OF SELENIUM WITH QTP

<table>
<thead>
<tr>
<th>Features</th>
<th>HP QTP</th>
<th>SELENIUM</th>
</tr>
</thead>
<tbody>
<tr>
<td>Programming knowledge</td>
<td>Required</td>
<td>Required</td>
</tr>
<tr>
<td>Record and Playback</td>
<td>Can only be used in Internet explorer.</td>
<td>Selenium ID to be used.</td>
</tr>
<tr>
<td>Data Driven Testing</td>
<td>Complex VB scripting required.</td>
<td>Requires extensive coding.</td>
</tr>
<tr>
<td>Database support</td>
<td>With the help of DSN.</td>
<td></td>
</tr>
<tr>
<td>Object Repository</td>
<td>Called as Window declarations. They can edited directed from the editor.</td>
<td>Non editable.</td>
</tr>
<tr>
<td>Test case</td>
<td>Block of coding statements required.</td>
<td>Automation scripts are written.</td>
</tr>
<tr>
<td>Object Oriented Language</td>
<td>VBScript.</td>
<td>Java,Python,Ruby,Perl,Php,C#.</td>
</tr>
<tr>
<td>support &amp; Scalability</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Functional Testing,Load</td>
<td>Complex code required.</td>
<td>Not available</td>
</tr>
<tr>
<td>Testing, Service monitoring</td>
<td></td>
<td></td>
</tr>
<tr>
<td>from one testscript</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Run test in cloud</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Test Development Environment</td>
<td>We can use wide range of IDEs like Eclipse, Netbeans, Visual Studio etc</td>
<td>Need Separate environment</td>
</tr>
</tbody>
</table>
### Result Reporting
- They are stored in binary files with extension .res. They can be converted into different formats. Multiple versions can be stored in the same file.
- Basic reporting is done.

### Defect management reporting
- In Built defect reporting.
- Not available.

### OS Support
- Windows only.
- Supports Windows PC/MAC/UNIX Platforms

### Test Management integration
- TD/QC will be easily integrated.
- Not available. Need to track separately

### Scheduled Execution
- Not available.
- Yes with complex code

### Cost
- Licensed and very expensive.
- Open Source (GPL 2, Apache 2) & Portable.

### Browser Support
- IE and Firefox.
- Almost all.

### Support Dialog boxes
- Supports all kinds of dialog boxes.
- Supports partially.

### Support for file upload
- Supports all kinds of file upload.
- Not available.

### Additional Plug-ins
- It also supports add-ons, but user needs to purchase license for them.
- It supports addition of plug-ins to achieve desired results that are not provided by Selenium Core. Since, selenium is open source, plug-ins are also available free of cost.

### Efforts and Skill
- It requires less effort to create a script, as it has a very good user friendly script development environment.
- User needs to have good amount of Java skill and more coding effort is required to implement the functions.

### V. CONCLUSIONS
Selenium is an open source software and also a web application testing tool. In a very short span of time, Selenium automation testing framework is gaining wide acceptance as a popular and successful mode of website automated testing. Selenium is the best tool for automated testing of Web-sites today. Selenium is a set of tools that supports rapid development of test automation scripts for web based applications. Selenium testing tools provides a rich set of testing functions specifically designed to fulfil needs of testing of a web based application. It is becoming very popular and it is the first/best choice of automation testers as well as organizations for automating the testing of Web Has great flexibility and extensibility. Along with its tight integration with the browser unmatched by available proprietary tools. Today everything is web based thus it is becoming more and more complex. For this, huge information platform, quick release cycle as well as quick regeneration is required. This requires the web application to be comprehensive, expansibility and efficiency. For this some...
framework also includes automation tools. you can reduce the cost incurred for licensing using QTP Using Selenium as the Functional Test Automation Tool.

ACKNOWLEDGEMENT

I thank Dr. T. V. Suresh Kumar, Prof. and Head, Dept. of MCA, MSRIT, Bangalore-54. For his continuous support and encouragement for completing this research paper and also thanks to MSRIT management.

REFERENCES

[8] http://docs.seleniumhq.org/docs/01_introducing_selenium.jsp